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Software Overview 
This user's guide describes how to use the MECcheckTM Software.  MECcheck  is designed to 
demonstrate compliance with the requirements of the Council of American Building Officials 
(CABO) Model Energy Code (MEC) and the International Code Council (ICC) International 
Energy Conservation Code (IECC).  It is the most flexible approach for meeting the MEC 
insulation and window requirements (refer to the Basic Requirements Guide in the MECcheck 
Workbook for additional requirements that must also be satisfied).  The MECcheck  software 
runs on the Microsoft Windows operating system. 

The MECcheck  software demonstrates compliance with the 1992, 1993, and 1995 editions of 
the MEC, the 1998 and 2000 editions of the IECC, and the following state and county 
residential codes:  Arkansas, Georgia, Massachusetts, Minnesota, New Hampshire, Vermont, 
Wisconsin, and Pima County, Arizona.  The software enables you to quickly compare different 
insulation levels in different parts of your building to arrive at a package that works best for 
you.  A report that can be submitted with your building plans for plan review is automatically 
generated. 

MECcheck  performs a simple U-factor x Area (UA) calculation for each building assembly to 
determine the overall UA of your building.  The UA that would result from a building 
conforming to the code requirements is compared against the UA for your building.  If the total 
heat loss (represented as a UA) through the envelope of your building does not exceed the total 
heat loss from the same building conforming to the code, then the software declares that you 
pass.  A high-efficiency equipment trade-off can also be performed. 

MECcheck  is appropriate for insulation and window trade-off calculations in residential 
detached one- and two-family buildings (referred to as single-family buildings) and 
multifamily buildings (such as apartments, condominiums, townhouses, and rowhouses).  

1992, 1993, and 1995 MEC and 1998 IECC and 2000 IECC 
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Multifamily buildings include residential buildings three stories or less in height with three or 
more attached dwelling units.   

New 
Hampshire 

The New Hampshire Code applies to residential structures under four stories in height and commercial 
structures under 4,000 square feet. 

Wisconsin The Wisconsin Residential Code does not include multifamily buildings. 

The MECcheck  software generates a report that lists the insulation and window levels of your 
proposed building, as well as the additional basic requirements found in the code.  The Basic 
Requirements Guide covers these other requirements in detail. 

Getting Started 

Conventions Used in This Guide 
The MECcheck  software can be used to demonstrate compliance with the 1992, 1993, and 
1995 editions of the MEC and the 1998 and 2000 editions of the IECC.  Although these codes 
are quite similar, there are some differences in the code requirements that occasionally must be 
reflected in the text of this user's guide.  When a block of text or a table only applies to a 
certain edition of the code, the applicable year is printed in the margin to the left of the text or 
table in the printed materials.   

Georgia Code years or state names in italics indicate text is only applicable to the indicated code edition. 

ALL 
CAPITALS 

ALL CAPITALS - File and directory names are capitalized. 

Bold Italics Bold Italics - Commands are shown in bold italics. 

Bold Initial 
Caps 

Bold Initial Caps - The keys on your keyboard, such as Tab and Shift+Tab, are shown in bold initial 
caps.  Some keyboard short cuts require you to hold down the Alt key while pressing another key.  For 
example, you press Alt+F to select the File menu.  In this guide, short cuts are shown in bold type. 

Italics Italics - An italic typeface is used to represent text as it appears on the screen in the program. 

→ An arrow is used to indicate a sequence of menu and submenu selections, such as Help→Help Topics. 

What you Need to Run MECcheck 
MECcheck  requires a Windows-based computer with at least the following hardware and 
software: 

• an 80486 processor 

• 6 MB extended RAM 

• a VGA or Super VGA monitor 

• a Microsoft-compatible mouse. 

MECcheck  is a Windows application and requires Microsoft Windows 95, 98, 2000, or NT. 

Installing MECcheck 
You must install MECcheck  onto your hard disk as instructed below.  Before installing the 
software, make sure your computer meets the minimum hardware and software requirements. 

To install MECcheck  from the CD-ROM: 
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1. Insert the CD into the CD drive of your computer.  The Installation dialogs will 
automatically appear. 

2. Follow the instructions on the screen. 

If the installation dialogs do not appear: 

1. Select the Start button and choose Run from the menu.  

2. Type <source>\MECcheck\setup.exe (where <source> is the CD drive letter). 

3. Click OK and follow the installation instructions. 

Starting MECcheck 
To run the MECcheck  software after installation, select Programs from the Start button and 
select MECcheck  from the programs list.  Alternatively, if you are using Windows Explorer or 
File Manager, you can change to the MECcheck  subdirectory and double-click on the 
MECcheck  icon. 

Screen Layout 
Title Bar - The title bar displays the name of the currently open project data file and the 
currently selected code.  If no file is open, the word Untitled is displayed. 

Menu Bar - The menu bar is located directly under the title bar and displays the available 
menus–File, Edit, View, Code and Help.  These menus are discussed in more detail in the 
following sections. 

Toolbar - The toolbar contains buttons with images representing some of the same options 
available in the menus. 

Folder Tabs - The Project, Envelope, and Mechanical folder tabs are used to choose the 
respective screens. 

Buttons - The buttons located directly under the Envelope and Mechanical folder tabs are used 
to create a list of building or HVAC components. 

 

User Prompts and Status Messages - The bottom left corner of the screen displays prompts 
and status messages. 

Compliance Status Bar 

Max. UA The Max. UA field displays the total UA of the code building (the house built to code requirements).  
To demonstrate compliance with the code, the UA of your house must be less than or equal to the UA 
displayed in this field. 
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Your UA The field labeled Your UA displays the UA of your proposed building based on the building 
components you chose and the information you supplied about each of these components.  The UA 
displayed in this field must be less than or equal to the UA displayed in the Code UA field to 
demonstrate compliance with the code. 

% Better 
Than Code 

MECcheck  compares the UA of your proposed house to the UA of the code house (the same house 
built to code requirements).  This comparison is expressed as a percentage and displayed in the % 
Better (Worse) Than Code field.  The percentage gives an indication of the amount by which your 
house exceeds or fails code requirements.  A green percentage indicates that your home's heat loss is 
less than that of the code house.  A red percentage indicates that your home's heat loss exceeds that of 
the code house. 

Colors Used in the Software 
Colors Used In Table Fields 

Black on white text indicates the data is editable by the user. 

Black on gray text indicates the data was calculated by the program and is not directly editable 
by the user. 

Dark blue on white text indicates the data was selected from a drop down list.  Clicking on 
such fields with the left mouse will re-display the appropriate list. 

Red on white text indicates data is either missing or not within a valid range. 

 

Colors Used In Compliance Fields 

Red on white compliance results indicates the design does not comply. 

Green on white compliance results indicates the design complies. 

 

Table Columns and Rows 
The Envelope and Mechanical screens have grid-like tables used to enter and store data.  The 
rows and columns in the tables can be deleted, moved, collapsed and expanded. 

Rows  
Selecting Rows - To select a row, click on the tree label corresponding to that row or click on 
the leftmost column of that row (the column containing row numbers).  The row will be 
reversed (black background) when correctly selected.  You can also select multiple rows by 
holding down the left mouse button on the left-hand column and dragging it over the desired 
rows. 

Moving Rows - Rows can be moved by: 

1. selecting the row(s) to be moved (as described above), 

2. releasing the mouse button, 

3. clicking the mouse button on the leftmost column of any of the selected rows (a 
small box will appear at the tail end of the arrow cursor), 

4. dragging the mouse to the new location – a thin red line will appear indicating 
where the row(s) should be placed, 
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5. releasing the mouse button when the red line has been placed in the desired 
location. 

  Arrow cursor when dragging rows or columns. 

A single table row can also be moved by dragging the corresponding row label in the tree 
located to the left of the table.  Click the mouse on the desired label and drag it to another label 
on the tree.  After releasing the mouse, the dragged label (and row) will be positioned directly 
under the label on which it was dropped.  Some restrictions apply to the placement of rows.  In 
the Envelope screen, for example, window and door rows can only be placed under above-
grade wall or basement wall rows.  Skylight rows can only be placed under ceiling rows. 

Collapsing and Expanding Rows - On the Envelope screen, rows can also be collapsed and 
expanded by using the tree located to the left of the table.  Rows that fall below a "parent" row 
on the tree can be collapsed so they are not displayed.  For example, an exterior wall row with 
several windows and doors under it can be collapsed to hide the windows and doors.  A tree 
label with a minus sign to the left of the label is already expanded.  It can be collapsed by 
clicking on the box containing the minus sign.  Tree labels that are already collapsed have a 
plus sign to the left of the label.  They can be expanded by clicking the box containing the plus 
sign.  Clicking the plus or minus sign to the left of the Building label will expand or collapse 
all rows in the table. 

Deleting Rows – Rows can be deleted by selecting the row or rows to be deleted and selecting 
Delete Row(s)  from the Edit menu or selecting the delete rows icon from the toolbar. 

 

Multiple consecutive rows can be selected by holding down the left mouse button on the left-
hand column and dragging it over the desired rows.  Non-consecutive rows can be selected by 
holding down the Ctrl key while clicking on the leftmost column of each row to be selected. 

In the Envelope screen, if you delete a wall or basement row with windows or doors linked to 
it, the windows and doors will also be deleted.  Likewise, deleting a ceiling row with a skylight 
linked to it will cause the skylight to be deleted as well. 

Duplicating Rows – Rows can be duplicated by selecting the row or rows to be duplicated and 
selecting Duplicate Row(s)  from the Edit menu or selecting the duplicate rows icon from the 
toolbar. 

 

Multiple rows can be duplicated, but they must be consecutive. 

Columns  
Selecting Columns - Select a single column by clicking the left mouse button on the column 
heading.  Select multiple columns by pressing the left mouse button and dragging it over the 
desired column headings.  Selected columns will be reversed (black background).   

Moving Columns - Columns can be moved by: 

1. selecting the column(s) to be moved (as described above), 

2. releasing the mouse button, 

3. clicking the mouse button on the column heading of any of the selected columns 
(a small box will appear at the tail end of the arrow cursor), 

4. dragging the mouse to the new location-a thin red line will appear indicating 
where the column(s) should be placed, 
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5. releasing the mouse button when the red line has been placed in the desired 
location. 

Changing Column Widths - Table column widths can also be modified.  To change the width 
of a column, move the mouse over the right edge of the corresponding column header until the 
mouse pointer changes to a double-sided arrow.    

When the mouse pointer changes, drag the column to the desired width.  Columns that have 
been totally collapsed can be restored by double-clicking the mouse on the column header 
separation (the vertical line in the top row representing the hidden column). 

Project Folder 
Your building's location and construction type (single family or multifamily) are entered in the 
Project screen.  MECcheck  lists the cities or counties for each state.  The location and 
construction type of your building are necessary for MECcheck  to determine compliance.  If 
this information is not accurate, the results will not be valid. 

New 
Hampshire 

The New Hampshire Code applies to residential structures under four stories in height and commercial 
structures under 4,000 square feet.  Since the code is the same for all locations within the state, there 
are no entries for location or construction type. 

Wisconsin The Wisconsin Residential Code does not include multifamily buildings. 

The Project screen also has input fields entitled Date of Plans, Title, Project, Company, and 
Notes.  All of the information entered in these fields is included in your project report.  None 
of this information is required by the software to determine compliance with the code.  This 
information may be useful, however, to the building department or as a way to track and label 
your reports. 

 
Project Folder 
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Whenever you exit MECcheck , the currently selected building location and construction type 
are saved.  When re-entering the software, the location and construction type fields are 
automatically updated to reflect your last entries. 

Project Folder Required Inputs 
State To choose a new state, select the arrow button to the right of the field.  A list appears containing 

state names.  If a state code is selected from the Code menu, the state corresponding to the new code 
will be the only one listed.   

City or 
County 

 

 

Each time you enter a new state, the list of cities or counties changes – reflecting only the cities or 
counties located in the new state.  To choose a new location, select the arrow button to the right of 
the field.  A list appears containing the names of cities or counties located in the selected state.  If 
you cannot find the city in which your building will be located, choose a city that is close to your 
building site and has similar weather conditions. 

New 
Hampshire 

The New Hampshire state code is the same for the entire state.  If you select New Hampshire from 
the Code menu, the City/County field will disappear. 

Construction 
Type 

The code specifies different requirements for 1- and 2-family detached (single family) buildings and 
multifamily buildings, so MECcheck  must know which of these construction types you are going to 
build.  You must select either the 1- and 2-Family, Detached or the Multifamily button. 

New 
Hampshire 

The New Hampshire residential code applies to all residential structures under four (4) stories in 
height and commercial structures under 4,000 ft2.  It does not distinguish between single family and 
multifamily buildings.  If you select New Hampshire from the Code menu, the Construction Type 
options will disappear. 

1- and 2- 
Family, 
Detached 

To choose single-family construction (defined as all detached one- and two-family dwellings), click 
on the 1- and 2-Family, Detached radio button with the mouse.   

Multifamily 
 
 
 

 
 

To choose multifamily construction, click on the Multifamily radio button with the mouse.  
Multifamily buildings are three stories or less in height and contain three or more attached dwelling 
units.  Apartments, condominiums, townhouses, dormitories, and rowhouses are included in this 
category.  Multifamily buildings can be considered as a whole or separate reports can be generated 
for each dwelling unit.  Where individual units are identical, one report may be submitted as 
representative of the others.  Contact the authority having jurisdiction to determine which approach 
to take. 

Massachusetts 
Heating 
System Type 

If the dwelling is primarily heated with electric resistance heating, select the Electric Resistance 
button.  If the dwelling is primarily heated with any other heating system, select the Other button.  
An electric heat pump is not electric resistance heating.  The code has more stringent envelope 
requirements for single-family dwellings with electric resistance heating. 

Wisconsin 
Heating 
System Type 

The code has more stringent requirements for electrically heated homes.  If the dwelling is primarily 
heated with electric heat (including electric heat pumps), select the Electric button.  If the dwelling 
is primarily heated with any other non-electric heating system, select the Non-Electric button. 

Sustainable 
Energy 
Standard 
Conditioned 
Floor Area 

If you are determining compliance to the Sustainable Energy Standard, you must enter the 
conditioned floor area.  If this information is not accurate, the results will not be valid.  The 
conditioned floor area includes the gross area of all heated and/or cooled rooms, including the floor 
area of heated or cooled basements. 



8 Software User’s Guide for all MEC and IECC Editions 

Project Folder Optional Inputs 
Date of 
Plans 

The Date of Plans field is used to record the date stamped on the building plans.  This date can be used 
to track the plans on which the MECcheck documentation is based, in the event that the plans are later 
modified. 

Title The Title field is a single-line text field used to enter a project title.  You can use the title to identify 
specific projects.  This title is displayed at the top of your report. 

Project  Enter a description of your project in the Project field (such as the project name and address).   

Company Enter a description of your company in the Company field (such as the name and address).   

Notes Enter any additional information in the Notes field.   

Envelope Folder 
 

 
Envelope Folder 

The blue-on-white buttons at the top of the Envelope screen are used for choosing the building 
components in your proposed design.  You can select from buttons representing general 
building components – ceilings, walls, basement walls, windows, skylights, doors, floors, slab 
floors, and crawl space walls.  When you select any of these buttons the component is added to 
the table on the Envelope screen.  The table continues to grow as you add new components.  
You may add as many components as you need to describe your building, including multiple 
components of the same type.  The status bar message at the bottom of the screen explains 
what type of information goes into the currently selected field. 

After you have filled in the information about each component, the program computes the UA 
of your proposed building and the UA of the code building.  The code building has the same 
dimensions as your building but conforms to the code requirements.  If the total UA of your 
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building is less than or equal to the total UA of the code building, your building complies with 
the code and the Compliance field displays the message "Passes."  

Ceilings 
Ceilings include opaque portions of the building envelope that are above conditioned space 
and are horizontal or tilted at less than 60 degrees from horizontal. 

Select the Ceiling button to add a ceiling component to the description of your design on the 
Envelope screen.  Each unique ceiling assembly should be entered as a separate component, 
but multiple ceiling elements sharing the same construction may be entered as one component 
with appropriate total area.   

Ceiling Types 
After selecting the Ceiling button, a new ceiling assembly is added to the table and a popup 
menu is displayed in the Assembly field.  Choose from the following ceiling types: 

Flat Ceiling 
or Scissor 
Truss 

Wood-frame ceiling structures with attics in which batt or loose-fill insulation is placed between and 
on top of structural ceiling members. 

Cathedral 
Ceiling (no 
attic) 

Sloped, wood-frame ceiling structures without attic spaces. 

Raised or 
Energy 
Truss 

Wood-frame ceiling structures with raised or oversized truss construction allowing the insulation to 
achieve its full thickness over the plate lines of exterior walls. 

Structural 
Insulated 
Panels 
(SIPs) 

Typically 4- to 6-in. stressed-skin panels with foam insulation sandwiched between oriented strand-
board (OSB).  For SIPs assemblies, you must provide the manufacturer-reported R-value in the 
Continuous Insulation R-Value field. 

Other Ceiling assemblies that do not fit into any of the other ceiling types, including steel-framed roofs.  If 
you use the Other ceiling type, you must enter an overall U-factor for the entire ceiling assembly 
(including air films). Be prepared to provide the building department with manufacturers' literature or 
documentation of U-factor calculations. 

Ceiling Software Inputs 
 

Gross Area Enter the gross area of the ceiling component in the Gross Area or Perimeter field.  The gross ceiling 
area includes the area of all skylights within the ceiling.  You must link the ceiling to the skylights 
within that ceiling by using the tree on the left side of the Envelope screen.  To link a skylight to a 
ceiling assembly, drag the skylight label on the tree to the ceiling label and release the mouse.  The 
ceiling area should be measured on the slope of the finished interior surface. 

Cavity 
Insulation  
R-Value 

Enter the R-value of any insulation to be installed in the cavities between ceiling structural members, 
including all blown insulation.  The insulating values of other parts of the building assemblies (e.g., 
gypsum board and air films) are accounted for by the program and should not be included. 

Continuous 
Insulation  
R-Value 

Enter the R-value of any continuous ceiling insulation.  Continuous insulation is insulation that runs 
continuously over structural members and is free of significant thermal bridging; such as rigid foam 
insulation above the ceiling deck.  For ventilated ceilings, insulating sheathing must be placed between 
the conditioned space and the ventilated portion of the ceiling (typically applied to the trusses or rafters 
immediately behind the drywall or other ceiling finish material).  For structural insulated panels, enter 
the manufacturer-reported R-value for the entire assembly. 



10 Software User’s Guide for all MEC and IECC Editions 

Assembly  
U-Factor 

If you have selected the Other ceiling type option, enter the overall U-factor of the ceiling assembly 
including exterior and interior air films.  Do not include the finished ceiling in the U-factor calculation 
if the space between ceiling and ceiling structure is used as an HVAC plenum.  Building departments 
may require supporting documentation for assemblies entered using the Other ceiling type and U-
Factor field. 

Walls 
Select the Wall button to add an above-grade wall component to the description of your design 
on the Envelope screen.  Each unique above-grade wall assembly should be entered as a 
separate component, but multiple wall elements sharing the same construction may be entered 
as one component with appropriate total area.  

Wall Types 

Wood 
Frame, 16" 
o.c. 

Wood frame walls with 16" on-center stud spacing.  The category is intended primarily for lightweight 
walls but may also be used for walls with masonry veneers. 

Wood 
Frame, 24" 
o.c. 

Wood frame walls with 24-in. on-center. stud spacing.  The category is intended primarily for 
lightweight walls but may also be used for walls with masonry veneers. 

Steel 
Frame, 16" 
o.c. 

Steel frame (stud) walls of any gauge or depth, with 16" on-center stud spacing.  The category is 
intended primarily for lightweight walls but may also be used for walls with masonry veneers.  

Steel 
Frame, 24" 
o.c. 

Steel frame (stud) walls of any gauge or depth, with 24" on-center stud spacing.  The category is 
intended primarily for lightweight walls but may also be used for walls with masonry veneers. 

Solid 
Concrete or 
Masonry 

Solid precast or poured-in-place concrete as well as concrete masonry units with grouted cells.  In 
making this selection, you must also indicate whether the insulation will be located on the interior or 
exterior of the wall.  If insulation will be placed on both the interior and exterior of the wall, select the 
option corresponding to the larger insulative R-value.  For example, if R-5 exterior sheathing will be 
used with R-13 interior cavity insulation on a furred concrete wall, select the Interior Insulation 
option.  To receive full credit for light-weight (insulated) concrete walls, use the Other wall type. 

Masonry 
Block with 
Empty Cells 

Concrete masonry block units with at least 50% of the cells free of grout.  In making this selection, 
you must also indicate whether the insulation will be located on the interior or exterior of the wall.  If 
insulation will be placed on both the interior and exterior of the wall, select the option corresponding 
to the larger insulative R-value.  To receive full credit for light-weight (insulated) concrete walls, use 
the Other wall type.   

Masonry 
Block with 
Integral 
Insulation 

Concrete masonry block units with integral insulation, such as perlite or rigid foam inserts.  Integral 
insulation means insulation placed within the cells.  Selecting this wall type gives you credit for 
integral insulation.  DO NOT enter values for cavity R-value and continuous R-value unless additional 
insulation will be installed.  In making this selection, you must also indicate whether the additional 
insulation will be located on the interior or exterior of the wall.  If additional insulation will be placed 
on both the interior and exterior of the wall, select the option corresponding to the larger insulative R-
value.  To receive full credit for light-weight (insulated) concrete walls, use the Other wall type. 
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Log 
 
 
 
 
 
 
 
Vermont 

Walls constructed from 5" or larger diameter logs. 

NOTE: Concrete, masonry, and log walls with 7-in or larger diameter logs receive a mass wall credit in 
some locations.  In order to qualify for this credit, the heat capacity of the exterior wall must be greater 
than or equal to 6 Btu/ft2 °F [123 kj/m2 °K] of exterior wall area.  Masonry and concrete walls having a 
mass greater than or equal to 30 lb/ft2of exterior wall area (146 kg/m2) will meet this requirement.  
Masonry and concrete walls with lesser mass should be entered as wood-framed walls.  Log walls with 
5-in and 6-in diameter logs may be entered as log walls, but will not receive the mass wall credit.   

The Vermont residential code has lesser overall thermal envelope requirements but greater heating 
system efficiency requirements for log wall homes.  Contact the Department of Public Service to find 
out more about log homes and their requirements. 

Structural 
Insulated 
Panels 
(SIPs) 

Typically 4- to 6-in. stressed-skin panels with foam insulation sandwiched between oriented strand-
board (OSB).  For SIPs assemblies, you must provide the manufacturer-reported R-value in the 
Continuous Insulation R-Value field. 

Insulated 
Concrete 
Forms 
(ICFs) 

ICFs are insulating, stay-in-place forms for poured concrete walls.  The forms, which remain a 
permanent part of the wall assembly, are either pre-formed interlocking blocks or separate panels 
connected with plastic ties.  For ICF systems, you must provide the manufacturer-reported R-value in 
the Continuous Insulation R-Value field.  This R-Value should include air films and all materials used 
in the assembly, including insulation but excluding soil effects.  The effects of mortar joints and steel 
framing reinforcement that penetrates insulation must be included.  The R-value of the insulation only 
may not be used.  To determine the total assembly R-value, manufacturers may use the Series-Parallel 
method described in the ASHRAE Fundamentals Handbook, or may provide third-party independent 
test results from a physical testing laboratory.  Acceptable physical testing procedures include ASTM 
C177, ASTM C518, ASTM C236 or ASTM C976.  Tested R-value results should be included with 
permit submittals. 

Other 
 
 
 
 

Wall assemblies that do not fit into any of the other above-grade wall types.  Also use the Other wall 
type to receive full credit for the extra insulative value of light-weight (insulated) concrete walls.  You 
must enter an overall U-factor for the entire wall assembly (including air films).  Be prepared to 
provide the building department with manufacturers' literature or documentation of U-factor 
calculations.   

Wisconsin Assembly U-factors entered under the Other wall type must be approved through the Department of 
Commerce. 

Wall Software Inputs 

Gross Area 

  

Enter the gross area of the wall component in the Gross Area or Perimeter field.  The gross wall area 
includes the area of all windows and doors within the wall.  You must link the wall to the windows and 
doors within that wall by using the tree on the left side of the Envelope screen.  To link a window or 
door to a wall, drag the window or door label on the tree to the wall label and release the mouse.  The 
gross wall area also includes the peripheral edges of floors (the area of the band joist and subfloor 
between floors).    

The gross area of any individual wall of a conditioned basement with an average depth less than 50% 
below grade should be entered as a wall (not as a basement).  In this case, the gross wall area includes 
the below-grade portion of the wall and the areas of doors and windows within those walls. 

Cavity 
Insulation  
R-Value 

Enter the R-value of any insulation to be installed in the cavities between above-grade wall structural 
members.  The insulating values of other parts of the building assembly (e.g., gypsum board and air 
films) are accounted for by the program and should not be included.   
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Continuous 
Insulation  
R-Value 

Enter the R-value of any continuous insulation in the above-grade wall. Continuous insulation is 
continuous over framing members or furring strips and is free of significant thermal bridging.  The R-
values of other parts of the building assembly (e.g., gypsum board and air films) are accounted for by 
the program and should not be entered.  Insulating sheathing installed on the exterior of above-grade 
walls is an example of continuous insulation.  For structural insulated panels and insulated concrete 
forms, enter the manufacturer-reported R-value for the entire assembly.     

Assembly  
U-Factor 

If you have selected the Other wall type, enter the overall U-factor of the above-grade wall assembly 
including exterior and interior air films.  Building departments may require supporting documentation 
for assemblies entered using the Other wall type and U-Factor field.  

Windows 
Windows are defined as any transparent or translucent section in an exterior building wall 
including glass block but excluding glass doors (which are entered using the Door button).  
Glazing having a slope greater than 60 degrees from horizontal is considered a window while 
glazing having a slope less than 60 degrees from horizontal is considered a skylight. 

Select the Window button to add a window component to the description of your design on the 
Envelope screen.  Each unique window assembly should be entered as a separate component, 
but multiple window elements having the same characteristics may be entered as one 
component with an appropriate total area.    

Windows must be linked to their corresponding wall component.  Link a window to a wall by 
using the tree on the left side of the Envelope screen.  Drag the window or door label on the 
tree to the wall label and release the mouse.  Windows in the exterior walls of conditioned 
basements should be included in the table and should be linked to their corresponding 
basement wall assembly.  Windows in unconditioned basements are NOT included.   

Window Types 

Frame Type The frame type enables you to identify the window frame material.  Use Other for frame types that do 
not fit into any of the other frame types. 

Glazing 
Layers 

The glazing layers enables you to identify the number of glazing layers in the windows (i.e., single, 
double, or triple).  Double Pane with Low-E is included because the performance impact of low-
emissivity films is similar to that of additional glass layers. 

Window Software Inputs 

Gross Area Enter the area of the entire window component in square feet.  Window area is the interior surface area 
of the entire assembly, including glazing, sash, curbing, and other framing elements.  The nominal area 
or rough opening is also acceptable for flat windows.   

U-Factor 
 
 
     

Enter the U-factor for each component in its corresponding U-Factor field.  U-factors for glazing must 
be tested and documented by the manufacturer in accordance with the NFRC test procedure or taken 
from the default glazing U-factors table in Appendix B.  Center-of-glass U-factors cannot be used. 

Minnesota The Minnesota residential code further requires that the area-weighted average U-factor of all 
foundation windows 5.6 ft2 and less not exceed 0.51.  The area-weighted average U-factor of all 
skylights may not exceed 0.55.  The area-weighted average U-factor for all other windows and sliding 
glass doors may not exceed 0.37. 
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Skylights 
Skylights are defined as any transparent or translucent section in a building ceiling.  Glazing 
having a slope less than 60 degrees from horizontal is considered a skylight, while glazing 
having a slope greater than 60 degrees from horizontal is considered a window. 

Select the Skylight button to add a skylight component to the description of your design on the 
Envelope screen.  Each unique skylight assembly should be entered as a separate component, 
but multiple skylight elements having the same characteristics may be entered as one 
component with the appropriate total area.   

Skylights must be linked to their corresponding ceiling component.  Link a skylight to a 
ceiling by using the tree on the left side of the Envelope screen.  Drag the skylight label on the 
tree to the ceiling label and release the mouse. 

Skylight Types 

Frame Type The frame type enables you to identify the skylight frame material.  Use Other for frame types that do 
not fit into any of the other frame types.   

Glazing 
Layers 

The glazing layers enables you to identify the number of glazing layers in the skylights (i.e., single, 
double, or triple).  Double Pane with Low-E is included because the performance impact of low-
emissivity films is similar to that of additional glass layers. 

Skylight Software Inputs 
Gross Area Enter the area of the entire skylight component in square feet.  Skylight area is the interior surface area 

of the entire assembly, including glazing and framing elements.  The nominal area or rough opening is 
also acceptable.   

U-Factor    Enter the U-factor for each component in its corresponding U-Factor field.  U-factors for glazing must 
be tested and documented by the manufacturer in accordance with the NFRC test procedure or taken 
from the default glazing U-factors table in Appendix B.  Center-of-glass U-factors cannot be used.   

Doors 
Select the Door button to add a door component to the description of your design on the 
Envelope screen.  Each unique door assembly should be entered as a separate component, but 
multiple door elements sharing the same construction may be entered as one component with 
the appropriate total area.  

Door Types 
Solid Exterior doors that are mostly opaque (i.e., glass covers 50% or less of the door's area). 

Glass Exterior doors that are mostly glazed (i.e., glass covers more than 50% of the door's area). 

Other Exterior doors that do not fit into any of the other door types.  You must enter a U-factor and you 
should be prepared to provide the building department with manufacturers' literature or documentation 
of U-factor calculations. 

Sidelites:  Decorative door sidelites can be included with the door area and U-factor if an aggregate U-
factor is known for the entire assembly (the door plus all sidelites).  If the U-factor rating does not 
include the sidelites, enter the sidelites separately as windows and use a default glazing U-factor from 
the table in Appendix B. 

Door Software Inputs 

Gross Area Enter the total area of the door in square feet including any glazed portions.  The nominal area or 
rough opening is also acceptable.   
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U-Factor      Door U-factors must be tested and documented by the manufacturer in accordance with the NFRC test 
procedure or taken from the default door U-factors table in Appendix B. 

If the door is rated with an aggregate R-value (an R-value that includes both the glass and 
opaque area), the following equation applies: 

U- Factor =  
1

R - Value
 

If an opaque door contains glass and an aggregate R-value or U-factor rating for that door is 
not available, enter the door's glass area as a separate glazing component, enter the opaque area 
as an opaque door component, and enter an opaque door U-factor taken from the table in 
Appendix B.  The U-factors listed in Appendix B are only for doors without glass. 

Basements 
Any individual wall of a conditioned basement with an average depth 50% or more below 
grade should be entered using the Basement button.  Walls of conditioned basements with an 
average depth LESS than 50% below grade should be entered as an above-grade wall using the 
Wall button. 

Select the Basement button to add a basement wall component to the description of your 
design on the Envelope screen.  Each unique basement wall assembly should be entered as a 
separate component, but multiple basement wall elements sharing the same construction may 
be entered as one component with the appropriate total area. 

2000 IECC The 2000 IECC requires exterior foundation wall insulation to have a rigid, opaque, and weather-
resistant covering that prevents the degradation of the insulation's performance.  The protective 
covering must cover the exposed (above-grade) area of the insulation and extend to a minimum of 6 in. 
(153 mm) below grade.  This requirement exists in the 2000 IECC. 

Basement Wall Types 

Solid 
Concrete or 
Masonry 

Solid precast or poured-in-place concrete as well as concrete masonry units with grouted cells.  To 
receive full credit for light-weight (insulated) concrete walls, use the Other basement wall type.   

Masonry 
Block with 
Empty Cells 

Concrete masonry block units with at least 50% of the cells free of grout.  To receive full credit for 
light-weight (insulated) concrete walls, use the Other basement wall type.   

Masonry 
Block with 
Integral 
Insulation 

Concrete masonry block units with integral insulation, such as perlite or rigid foam inserts.  Integral 
insulation means insulation placed within the cells.  Selecting this wall type gives you credit for 
integral insulation.  DO NOT enter values for cavity R-value and continuous R-value unless additional 
insulation will be installed.  To receive full credit for light-weight (insulated) concrete walls, use the 
Other basement wall type.    

Wood 
Frame 

Wood-frame walls with any stud spacing. 
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Insulated 
Concrete 
Forms 
(ICFs) 

ICFs are insulating, stay-in-place forms for poured concrete walls.  The forms, which remain a 
permanent part of the wall assembly, are either pre-formed interlocking blocks or separate panels 
connected with plastic ties.  For ICF systems, you must provide the manufacturer-reported R-value in 
the Continuous Insulation R-Value field.  The Assembly R-Value should include air films and all 
materials used in the assembly, including insulation but excluding soil effects.  The effects of mortar 
joints and steel framing reinforcement that penetrates insulation must be included.  The R-value of the 
insulation only may not be used.  To determine the total assembly R-value, manufacturers may use the 
Series-Parallel method described in the ASHRAE Fundamentals Handbook, or may provide third-party 
independent test results from a physical testing laboratory.  Acceptable physical testing procedures 
include ASTM C177, ASTM C518, ASTM C236 or ASTM C976.  Tested R-value results should be 
included with permit submittals. 

Other Basement wall assemblies that do not fit into any of the other basement wall types.  Also use the Other 
basement wall type to receive full credit for the extra insulative value of light-weight (insulated) 
concrete walls.  If you use the Other basement wall type, you must enter an overall U-factor for the 
entire wall assembly (including interior air film but excluding earth).  Be prepared to provide U-factor 
calculations or documentation from manufacturer's literature to the building department.   

Wisconsin Assembly U-factors entered under the Other wall type must be approved through the Department of 
Commerce. 

Basement Software Inputs 
After selecting a basement wall type, a basement wall illustration will appear with input boxes 
for the basement wall height, depth below grade, and depth of insulation.  The illustration 
helps identify the dimensions being requested.  You may enter basement wall dimensions 
directly into this illustration and select the OK button to have them transferred to the 
corresponding row in the table on the Envelope screen.  If you prefer to enter the dimensions 
directly into the table on the Envelope screen, you can select Cancel to remove the illustration 
without entering dimensions.  To view the basement wall illustration and inputs at a later time, 
click the right-mouse button anywhere on the basement row and select Edit Basement Inputs 
from the popup menu. 
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Wall Height 
(ft) 

Provide the height of the wall (ft) as measured from the top of the wall to basement floor.  If the height 
is not uniform, provide an average height.  If you are entering a partial basement wall component (such 
as wood kneewalls), enter the height of the wall section instead of the height of the entire wall. 

Depth 
Below 
Grade (ft) 

Provide the depth (ft) that the wall extends from the finished outside grade surface to the basement 
floor.  If the grade is sloped or uneven, provide an average depth below grade.  If you are entering a 
partial basement wall component (such as wood kneewalls), enter the depth below grade of the wall 
section instead of the depth below grade of the entire wall.  For wood kneewalls, the wall section may 
be entirely above grade, in which case you would enter 0. 

Depth of 
Insulation 
(ft) 

Basement insulation requirements are for the full depth of the basement wall (up to 10 ft).  MECcheck , 
however, allows the depth of the basement wall insulation to be traded against other envelope 
components.  Therefore, you must indicate the depth (ft) of the insulation you intend to install on your 
basement wall as measured from the top of the wall to where the insulation stops.  The insulation must 
extend from the top of the basement wall downward to a depth equal to the value entered in this field.  
Note that for a fully insulated wall the depth of insulation should be equal to the height of the wall.  
For basement walls with non-uniform insulation depths, enter an average.  MECcheck  accepts 
basement insulation depths from 0 to 12 ft.  If you enter an insulation depth of 0, the program assumes 
no insulation is installed regardless of the values in the Cavity Insulation R-Value and Continuous 
Insulation R-Value fields. 

Gross Area Enter the gross area of the basement wall component in the Gross Area or Perimeter field.  The gross 
basement wall area includes the area of all windows and doors within the wall.  You must link the wall 
to the windows and doors within that wall by using the tree on the left side of the Envelope screen.  To 
link a window or door to a wall, drag the window or door label on the tree to the wall label and release 
the mouse. 

The gross area of any individual wall of a conditioned basement with an average depth less than 50% 
below grade should be entered as a wall (not as a basement). 

Cavity 
Insulation  
R-Value 

If the basement will be furred, provide the R-value of the insulation to be installed between furring in 
the Cavity Insulation R-Value field.  Do not include the R-value of other materials (such as interior 
drywall). 

Continuous 
Insulation  
R-Value 

Enter continuous insulation in the Continuous Insulation R-Value field.  Continuous insulation 
includes exterior rigid foam products and any continuous insulation installed on the exterior or interior 
of an unfurred basement wall.  For ICFs, enter the manufacturer-reported R-value for the entire 
assembly in the Continuous Insulation R-Value field. 

Georgia The Georgia Residential Code does not allow below-grade exterior foam plastics.  If a non-zero value 
is entered in the Continuous Insulation R-Value field, the output report will identify this entry as 
interior continuous insulation. 

Minnesota R-5 is the minimum basement wall insulation R-value allowed by the Minnesota residential code. 

Example 1:  Wood Kneewalls 
Assume a basement is to be constructed with 3-ft-high wood kneewalls built on a 5-ft-high 
concrete foundation.  R-13 insulation will be installed in the wood kneewall cavities and R-5 
rigid insulation will be installed on the concrete foundation walls. 

The wood kneewalls are completely above grade and fully insulated.  The concrete foundation 
walls are 4 ft. below grade and fully insulated. 

Create one basement wall component for the wood kneewalls and enter the following 
information: 

• Wall Height     3 ft. 

• Depth B.G.    0 ft. 

• Depth of Insul    3 ft. 
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Create a second basement wall component for the concrete foundation and enter the following 
information: 

• Wall Height     5 ft. 

• Depth B.G.    4 ft. 

• Depth of Insul    5 ft. 

Two basement wall components will be added to your list of building components.  Provide 
the gross wall area of the wood kneewalls and enter the insulation R-value as R-13 in the 
Cavity Insulation R-Value field.  Provide the gross wall area of the concrete foundation walls 
and enter the cavity R-value as R-5 in the Continuous Insulation R-Value field. 

Example 2:  Walk-Out Basement 
Assume an 8-ft. basement is to be built on a slope so that the front wall is 7 ft. below grade and 
the rear wall is totally above grade.  The ground level along both side walls is  sloped so that 
approximately 50% of each wall is below grade.  The rear basement wall will be wood-frame 
construction with R-19 cavity insulation.  The other three walls will be concrete walls with R-
10 rigid insulation.  All four walls will be fully insulated. 

Create one basement component for the front wall and enter the following information: 

• Wall Height     8 ft. 

• Depth B.G.    7 ft. 

• Depth of Insul    8 ft. 

The two side walls are at least 50% below grade, so they are entered as a basement wall 
component.  If they were less than 50% below grade, they would be entered as an above-grade 
wall component.  Therefore, create a second basement wall component for the two side walls 
and enter the following information: 

• Wall Height     8 ft. 

• Depth B.G.    4 ft. 

• Depth of Insul    8 ft. 

The rear wall is fully above grade and should be entered as an above-grade wall using the Wall 
button.  Note that the basement floor along this wall should be considered a slab-on-grade 
component.  Create a slab component using the Slab button and enter the length of the 
basement floor along this wall in the Gross Area or Perimeter field. 

Example 3:  Below-Grade Exterior Insulation 
An 8-ft. high by 21-ft. wide foundation wall is 7 ft. below grade and is to be insulated using R-
5 exterior rigid foam.  The insulation will start at grade level and run down to the bottom of the 
foundation wall.  There is 1 foot of uninsulated exposed above-grade wall.  The wall has no 
openings. 

This wall is entered in MECcheck  by creating two basement wall components.  The first 
component will be used for entering the uninsulated above-grade portion of the wall. 

Select the Basement button and enter the following information: 

• Wall Height     1 ft. 

• Depth B.G.    0 ft. 

• Depth of Insul    0 ft. 
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The second component will be used for entering the insulated below-grade portion of the wall.  
Select the Basement button again and enter the following information: 

• Wall Height     7 ft. 

• Depth B.G.    7 ft. 

• Depth of Insul    7 ft. 

After these components have been created, enter the gross area of each component and the R-
value of the insulation used on the below-grade component.   

 

Example 4:  Draped Interior Insulation 
Some builders choose to insulate the interior of basement walls with faced insulation batts.  
Some products have reinforced stapling tabs at the top and bottom of the batts for installation 
on furring strips using a hammer-stapler.  They might also be power-nailed directly to a solid 
concrete or block wall or installed on pins glued directly to the foundation wall.  The batts 
typically come in 4-ft. wide rolls, and are sometimes installed on only the top four feet of the 
wall. 

A solid concrete basement has 10-ft. high walls and is buried 9 ft. below grade.  Foil faced, R-
11 basement batt insulation is to be installed on the first four feet of the interior of the 
basement walls.  Select the Basement button, select the Solid Concrete or Masonry option, and 
enter the following information: 

• Wall Height     10 ft. 

• Depth B.G.    9 ft. 

• Depth of Insul    4 ft. 

With these inputs, the software will assume the lower 6 ft. of the wall is uninsulated.  The R-
value of the uninsulated concrete wall is provided by the software and should not be entered by 
the user.  After the basement component has been created, enter the sum of the gross area of all 



MECcheckTM Version 3.0 19 

exterior basement walls in the Gross Area or Perimeter field and enter the assembly R-value 
(R-11) in the Continuous Insulation R-Value field.  Note that the gross area equals the sum of 
the insulated and uninsulated areas. 

Floors 
Select the Floor button to add a floor component to the description of your design on the 
Envelope screen.  Each unique exposed floor assembly should be entered as a separate 
component, but multiple floor elements sharing the same construction may be entered as one 
component with the appropriate total area. 

Floor Types 

All-Wood 
Joist/Truss 

Any structural wood floor in which insulation is placed between the structural members; e.g., batt 
insulation between wood floor joists. 

Structural 
Insulated 
Panels 
(SIPs) 

Typically 4- to 6-in. stressed-skin panels with foam insulation sandwiched between oriented strand-
board (OSB).  For SIPs assemblies, you must provide the manufacturer-reported R-value in the 
Continuous Insulation R-Value field. 

Other Floor assemblies that do not fit into any of the other floor types. You must enter an overall U-factor for 
the entire floor assembly (including air films).  Be prepared to provide the building department with 
manufacturers' literature or documentation of U-factor calculations. 

Floor 
Location 

For all floor types you must also indicate whether the floor is located over an unconditioned space or 
over outside air.  Floors over unconditioned space include all floors over unconditioned (neither heated 
nor cooled) basements, crawl spaces, and garages.  Floors over outside air include floor cantilevers, 
floors of an elevated home, and floors over overhangs (such as the floor directly above a recessed 
entryway or open carport).  Floors over heated spaces are not part of the building envelope and should 
not be included.  Concrete slab-on-grade floors are entered separately using the Slab button. 

Floor Software Inputs 

Gross Area Enter the gross area of the floor (in square feet) along the boundary where it separates conditioned 
from unconditioned space. 

Cavity 
Insulation  
R-Value 

Enter the R-value of any insulation to be installed in the cavities between floor structural members.  
The insulating values of other parts of the building assembly (e.g., subfloor and air films) are 
accounted for by the program. 

Continuous 
Insulation  
R-Value 

Enter the R-value of any continuous floor insulation.  Continuous insulation is insulation that runs 
continuously over structural members and is free of significant thermal bridging.  The insulating 
values of other parts of the building assembly (e.g., subfloor and air films) are accounted for by the 
program. 

Assembly  
U-Factor 

If you have selected the Other floor type option, you must enter the overall U-factor of the floor 
assembly including exterior and interior air films.  Building departments may require supporting 
documentation for assemblies entered using the Other floor type and U-Factor field. 

Slab Floors 
Select the Slab button to add a concrete slab-on-grade component to the description of your 
design on the Envelope screen.  Slab-on-grade components include all slab edges that are part 
of the building envelope and are less than 12 in. below grade (i.e., all edges separating 
conditioned from unconditioned space).  Edges of slab floors over 12 in. below grade (such as 
basement floors) are not subject to code requirements and do not need to be entered in the 
software.  Each unique concrete slab/insulation combination (i.e., insulation R-value and 
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depth) should be entered separately, but all slabs sharing insulation methods may be entered as 
a single component with the appropriate total perimeter length. 

2000 IECC The 2000 IECC requires slab perimeter insulation to have a rigid, opaque, and weather-resistant 
covering that prevents the degradation of the insulation's performance.  The protective covering must 
cover the exposed (above-grade) area of the insulation and extend to a minimum of 6 in. (153 mm) 
below grade.  This requirement exists in the 2000 IECC. 

Slab Types 
Unheated A slab that is not heated (see below). 

Heated A heated slab is one in which the heating elements or hot air distribution system is in contact with or 
placed within the slab or the subgrade.  Heated slabs have higher insulation requirements than 
unheated slabs under the code.  

Georgia The Georgia Residential Code does not allow below-grade exterior foam plastics, but does give some 
credit for carpet or hardwood on plywood applied to slab floors.  If the code is set to Georgia, you will 
also be asked to indicate whether the slab is covered with either of these treatments. 

Minnesota R-5 is the minimum slab perimeter insulation R-value allowed by the Minnesota residential code. 

Slab Software Inputs 
After selecting a slab type, an illustration of various slab configurations will appear with an 
input box for the depth of insulation.  The illustration helps identify the dimension being 
requested for various insulation configurations.  You may enter the depth of insulation directly 
into this illustration and select the OK button to have it transferred to the corresponding row in 
the table on the Envelope screen.  If you prefer to enter the insulation depth directly into the 
table on the Envelope screen, you can select Cancel to remove the illustration without entering 
a value.  To view the slab illustration at a later time, click the right-mouse button anywhere on 
the slab row and select Edit Slab Input from the popup menu. 
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Depth of 
Insulation 

Enter the depth (ft) of the insulation you intend to install as measured from the top of the slab to where 
the insulation stops.  This distance should include the total vertical plus horizontal distance.  Refer to 
the glossary definition of Slab Insulation for a description and illustration of acceptable configurations.  
If you enter a depth of 0, the program assumes no insulation is to be installed.  

Perimeter Enter the perimeter of the on-grade slab component in feet in the Gross Area or Perimeter field.  The 
slab perimeter should include the length of all edges of a slab foundation that are part of the building 
envelope and are less than 12 in. below grade. 

Continuous  
R-Value 

Enter the R-value of the slab perimeter insulation.   

Georgia The Georgia Residential Code does not allow below-grade exterior foam plastics.  The Continuous 
Insulation R-Value field is disabled when the code is set to Georgia. 

Crawl Space Walls 
The crawl space wall option is for walls of unventilated crawl spaces (i.e. not directly vented to 
the outside).  If you are insulating the floor above the crawl space, do not use the crawl space 
walls option.   

Select the Crawl button to add a crawl space wall component to the description of your design 
on the Envelope screen.  Each unique crawl space wall assembly should be entered as a 
separate component, but multiple crawl space wall elements sharing the same construction 
may be entered as one component with the appropriate total area. 
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Crawl Space Wall Types 
Solid 
Concrete or 
Masonry 

Solid precast or poured-in-place concrete as well as concrete masonry units with grouted cells.  To 
receive full credit for light-weight (insulated) concrete walls, use the Other crawl space wall type.   

Masonry 
Block with 
Empty Cells 

Concrete masonry block units with at least 50% of the cells free of grout.  To receive full credit for 
light-weight (insulated) concrete walls, use the Other crawl space wall type.   

Masonry 
Block with 
Integral 
Insulation 

Concrete masonry block units with integral insulation, such as perlite or rigid foam inserts.  Integral 
insulation means insulation placed within the cells.  Selecting this wall type gives you credit for 
integral insulation.  DO NOT enter values for cavity R-value and continuous R-value unless additional 
insulation will be installed.  To receive full credit for light-weight (insulated) concrete walls, use the 
Other crawl space wall type.   

Wood 
Frame 

Wood-frame walls with any stud spacing. 

Insulated 
Concrete 
Forms 
(ICFs) 

ICFs are insulating, stay-in-place forms for poured concrete walls.  The forms, which remain a 
permanent part of the wall assembly, are either pre-formed interlocking blocks or separate panels 
connected with plastic ties.  For ICF systems, you must provide the manufacturer-reported R-value in 
the Continuous R-Value field. 

Other Crawl space wall assemblies that do not fit into any of the other crawl space wall types.  Also use the 
Other crawl space wall type to receive full credit for the extra insulative value of light-weight 
(insulated) concrete walls.  If you use the Other crawl space wall type, you must enter an overall U-
factor for the entire wall assembly (including interior air film but excluding earth).  Be prepared to 
provide U-factor calculations or documentation from manufacturer's literature to the building 
department.   

Crawl Space Wall Software Inputs 
After selecting a crawl space wall type, a crawl space wall illustration will appear with input 
boxes for the crawl space wall height, depth below grade, depth of insulation, and depth below 
inside grade.  The illustration helps identify the dimensions being requested.  You may enter 
crawl space wall dimensions directly into this illustration and select the OK button to have 
them transferred to the corresponding row in the table on the Envelope screen.  If you prefer to 
enter the dimensions directly into the table on the Envelope screen, you can select Cancel to 
remove the illustration without entering dimensions.  To view the crawl space wall illustration 
and inputs at a later time, click the right-mouse button anywhere on the crawl space row and 
select Edit Crawl Inputs from the popup menu. 
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Wall Height 
(ft) 

Provide the height of the wall (ft) as measured from the sill to the top of the footing. 

Depth 
Below 
Grade (ft) 

Provide the depth (ft) that the wall extends from the outside finished grade surface to the top of the 
footing. 

Depth of 
Insulation 
(ft) 

Provide the depth (ft) of the insulation you intend to install as measured from the top of the wall to 
where the insulation stops.  This distance should include the total vertical plus horizontal distance.  
Because the horizontal distance is included, the depth of insulation may be greater than the height of 
the wall.  If you enter a depth of 0, the program assumes no insulation is to be installed. 

Inside 
Depth 
Below 
Grade (ft) 

Provide the depth (ft) as measured from the inside grade to the top of the footing. 

Gross Area Enter the gross area of the crawl space wall component in the Gross Area or Perimeter field.  The area 
should include the area of the entire wall as measured from the sill to the top of the footing, even if 
only a portion of the wall is insulated. 

Cavity 
Insulation  
R-Value 

Provide the R-value of any insulation to be installed between structural members in the Cavity 
Insulation R-Value field.  Do not include the R-value of other materials. 

Continuous 
Insulation  
R-Value 

Continuous insulation includes exterior rigid foam products and any continuous insulation installed on 
the exterior or interior of the wall.  For ICFs, enter the manufacturer-reported R-value for the entire 
assembly in the Continuous Insulation R-Value field. 

Georgia The Georgia Residential Code does not allow below-grade exterior foam plastics.  If a non-zero value 
is entered in the Continuous Insulation R-Value field, the output report will identify this entry as 
interior continuous insulation. 
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Minnesota R-5 is the minimum crawl space wall insulation R-value allowed by the Minnesota residential code. 

Mechanical Folder 
Use the blue-on-white buttons at the top of the Mechanical folder to enter the HVAC 
equipment in your proposed design.  Completion of this section of the software is entirely 
optional.  However, using high-efficiency HVAC equipment may improve the percentage by 
which your building compares with the code building.  The message at the bottom of the 
screen explains what type of information goes into the currently selected field. 

HVAC Efficiency 
Trade-offs are allowed for efficient gas and oil furnaces, boilers, and electric heat pumps and 
air conditioners.  No credit is given for electric resistance heating. 

Minimum-required heating and cooling equipment efficiencies are displayed in the Minimum 
Efficiency column.  If the efficiency of the equipment you plan to install exceeds these 
minimums, you qualify for the high-efficiency equipment credit.  Enter the annual fuel 
utilization efficiency (AFUE), heating seasonal performance factor (HSPF), or seasonal energy 
efficiency ratio (SEER) in the appropriate column. 

You can receive credit for only one piece of heating equipment and one piece of cooling 
equipment (or a single heat pump).  When multiple heating equipment or multiple cooling 
equipment is entered, the least efficient equipment will be used to determine compliance.  
However, if two furnaces having different efficiencies will be installed, you may create a 
single furnace entry and enter the average efficiency of both units in the Heating Efficiency 
field.  In this case, modify the output report to indicate that the reported efficiency is an 
average.  Enter the make and model number of BOTH pieces of equipment on the line 
provided in the Inspection Checklist portion of the output report. 

The high-efficiency equipment credit is applied as a percent increase in the code house UA.  
To see how much credit you are getting, observe the UA value displayed in the Code UA field.  
The UA will probably be smaller before taking the credit than after.  Some locations along the 
California coast do not qualify for the cooling equipment credit. 

Wisconsin The Wisconsin residential code requires furnaces (non-electric) to have an efficiency rating of 90% or 
better to receive credit.  Buildings heated with heat pumps are treated like homes with electric 
resistance heating.  However, credit is given for heat pumps with HSPF ratings of 7.8 or better.  Boiler 
systems receive credit for any value above 80%. 
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Mechanical Folder 

Wisconsin Heating Loads   
 The Wisconsin residential code requires a load calculation for sizing the heating equipment of 
the building.  In the Loads folder, enter values for the floor area, ceiling height, infiltration 
rate, and oversizing factor.  Once these values are entered into the software, the Total Building 
Heating Load is calculated and can be used for selecting properly sized heating equipment.  
The total building heating load is the sum of the loads from the assemblies entered in the 
Envelope folder (Conductive Losses), the infiltration loads (Infiltration Losses), and the loads 
resulting from the oversizing factor (Oversizing Factor Losses). 

Conditioned 
Floor Area 

The conditioned floor area includes the gross floor area of all heated rooms, including heated basement 
floor area. 

Average 
Ceiling 
Height 

The average ceiling height is the area-weighted average height of the ceiling as measured from the 
finished floor to the underside of the ceiling. 

Infiltration 
Rate 

The infiltration rate is the normalized air changes per hour that is anticipated for your building.  The 
software will not accept values above 0.5  ACH or below 0.20 ACH. 

Equipment 
Oversizing 
Factor 

The equipment oversizing factor is a percentage indicating the amount of oversizing you desire in 
selecting your heating equipment.  The software will not accept values over 15%. 
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Menus 
The menu bar located at the top of the Envelope screen is used to select the File, Edit, View, 
Code, and Help menus. 

File Menu 
The data you enter into MECcheck  can be stored on your hard disk in a project data file.  
Separate data files can be created for different building projects or for alternate designs of the 
same project.  Data files allow you to retrieve and alter designs at any time.  Report files allow 
you to print the information you have entered and to document the compliance results 
determined by MECcheck .  The File menu contains options allowing you to create (New), 
retrieve (Open), and save project data files and to print project reports. 

Data files created by MECcheck  must have the extension .CCK, and report files must have the 
extension .RPT.  If you prefer, when you are asked to provide a filename, you may leave the 
extensions off and let MECcheck  enter them for you. 

 
File Menu 

New 

 

The New option allows you to erase the current data and begin a new project data file.  When you 
select New and unsaved data exists , MECcheck  asks if you wish to save the current data.  Select Yes to 
save the current data or No if you do not want to save the current data.  If you select Yes and a file is 
already open, the open file is updated to contain the current data.  If no file is open, the Files screen 
appears and you are asked for a filename to which the data will be saved.  You can also open a new 
file by selecting the corresponding icon from the toolbar.  

  

Open When you want to revise or examine an existing file, you must retrieve a copy of the file by bringing it 
to the screen.  This is referred to as opening the file.  The Open option allows you to open an existing 
project data file.  When you select Open, the Files screen appears and you are asked for the filename 
of the project data file to retrieve.  If unsaved data exists, you are asked if you wish to save the current 
data before opening the new file.  If an unsaved file is already open, you are asked if you wish to save 
the currently open file before opening the new file.  You can also open an existing file by selecting the 
corresponding icon from the toolbar. 
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Save The Save option allows you to save your current data to the filename shown on the title bar.  If no file 
is open, the Files screen appears and you are asked for a filename.  You can also save data by selecting 
the corresponding icon from the toolbar. 

 

Save As The Save As option allows you to save your current project data file to a new name.  This option is 
useful when an existing file is opened then modified.  If you want to save copies of both the original 
and the modified file, use Save As to rename the modified file. 

Print 
Report 

This option allows you to print a report listing project data and compliance results.  A popup window 
is displayed from which you can elect to print a Compliance Report, an Inspection Checklist, or both.  
After choosing the report types to print, the Print dialog box will appear allowing you to select the 
number of copies and the printer.  You can also print reports by selecting the corresponding icon from 
the toolbar.  The print icon can be used for direct printing, in which case the printer setup dialog is not 
displayed and the report is sent to the default printer. 

 

Print 
Preview 

Select this option to view the Compliance Report and/or Inspection Checklist before printing. 

Print Setup Select this option to change printer settings. 

Save Report This option allows you to save a report to a file.  A popup window is displayed from which you can 
elect to generate a Compliance Report, an Inspection Checklist, or both.  After choosing the report 
types, the Save Report dialog box will appear allowing you to provide a name for the file.  The report 
will be saved in Rich Text Format (RTF), which can be loaded into most text processing software. 

Exit The Exit option allows you to exit MECcheck . 

Edit Menu 
Use the Edit menu to cut, copy, and paste data in editable fields, and to delete and duplicate 
entire rows.  Editable fields include: 

• The Date of Plans, Title, Project, Company, and Notes fields on the Project 
screen 

• All black-on-white (or red-on-white) fields in the tables on the Envelope and 
Mechanical screens 

• The tree labels corresponding to these tables when in edit mode (tree labels are 
put into edit mode by double-clicking on them).   

 
Edit Menu  
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Cut The Cut option will delete highlighted text in an editable field and copy it to the clipboard.  The 
deleted text can be pasted into another editable field.  You can also cut text by selecting the 
corresponding icon from the toolbar. 

   

Copy The Copy option will copy highlighted text in an editable field to the clipboard.  The copied text can be 
pasted into another editable field.  You can also copy text by selecting the corresponding icon from the 
toolbar. 

 

Paste The Paste option will paste the last copied text into the selected field at the current cursor location.  
You can also paste text by selecting the corresponding icon from the toolbar. 

 

Delete 
Row(s) 

The Delete Row(s)  option will delete all selected rows.  To select a row, click on the tree label 
corresponding to that row or click on the leftmost column of that row (the column containing row 
numbers).  Multiple consecutive rows can be selected by holding down the left mouse button on the 
left-hand column and dragging it over the desired rows.  Non-consecutive rows can be selected by 
holding down the Ctrl key while clicking on the leftmost column of each row to be selected.  You can 
also delete rows by selecting the corresponding icon from the toolbar. 

 

Duplicate 
Row(s) 

The Duplicate Row(s)  option will duplicate one or more consecutive selected rows.  If non-consecutive 
rows are selected, this option will be disabled.  To select a row, click on the tree label corresponding to 
that row or click on the leftmost column of that row (the column containing row numbers).  Multiple 
consecutive rows can be selected by holding down the left mouse button on the left-hand column and 
dragging it over the desired rows.  You can also duplicate rows by selecting the corresponding icon 
from the toolbar. 

 

View Menu 

 
View Menu  

Toolbar Toggle the Toolbar option to display and hide the toolbar at the top of the screen. 

Status Bar Toggle the Status Bar option to display and hide the status bar at the bottom of the screen. 

Minnesota 
Proposed 
and 
Maximum  
U-Values 

 The Proposed and Maximum U-Values screen shows the maximum U-value requirements allowed by 
the Minnesota residential code.  The screen displays the maximum U-values for glazing and floors and 
compares these to the area-weighted average U-values for your proposed components.  If the area-
weighted average U-values of your glazing or floor components exceeds any of the maximums on this 
screen, your building will not comply.  If the glazing U-value maximum is exceeded, the Compliance 
field will display the message Glazing Exceeds Maximum in red letters.  If the floor U-value maximum 
is exceeded, the Compliance field will display the message Floor Uo Exceeds Maximum in red letters. 
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Options Menu 

 

 

Comments/ 
Description 
(Envelope)  

Select this option to create a Comments/Description column on the Envelope folder.  Use the 
Comments/Description column to type additional information about a building assembly that you wish 
to be included in the Inspection Checklist, such as its location.  The blank Comment lines provided in 
the Inspection Checklist are replaced with any text entered in this column. 

Code Menu 
The Code menu is used to select the code edition applicable to your jurisdiction. 

 
Code Menu 

Tools Menu 
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AreaCalc 
Take-Off 
Tool 

This option launches the AreaCalc software tool that can be used to do building take-offs.  The areas 
computed in AreaCalc can be transferred directly to MECcheck . 

Help Menu 
The Help menu provides general information on how to use MECcheck .   

 
Help Menu 

 

Help Topics The Help Topics option displays the help topics available for MECcheck . 

About 
MECcheck 

The About MECcheck  option displays the program's version number and release date. 

Context Menu 
Clicking the right mouse button on a tree label or table displays a pop-up list, referred to as a 
context menu.  The context menu options are applied to a single field in a table or to an entire 
row in a table, depending on where the mouse is clicked.  If the mouse is clicked on a tree 
label, the menu options are applied to the row corresponding to that label.  If the mouse is 
clicked on the left field of a row in a table, the row is selected and the options are applied to 
the entire row.  Some options are applicable to individual fields of a table, and the mouse must 
be clicked on the given field to activate the option. 

Cut, Copy, 
Paste 

The Cut, Copy, and Paste options are available from the Edit menu in the menu bar, from toolbar 
buttons, and from the context menu.  See the Edit Menu section for a description of these options.  The 
Cut, Copy, and Paste options are applied to individual fields in a table.   

Delete 
Row(s), 
Duplicate 
Row(s) 

 The Delete Row(s), Duplicate Row(s)  options are available from the Edit menu, the toolbar, and the 
context menu.  See the Edit Menu section for a description of these options.  The Delete Row(s), 
Duplicate Row(s)  options apply to selected rows.    

Use Default The Use Default option enables you to enter a default U-factor for windows, skylights, and doors that 
do not have an NFRC rating.  The Use Default option can be selected by clicking the right mouse 
button in the U-Factor column of any window, skylight, or door assembly.  A table of default U-
factors based on characteristics of the given assembly will be displayed.  Choose the U-factor 
corresponding to the characteristics of your assembly, then select the OK button to transfer this default 
to the table on the Envelope screen. 

Edit Text The Edit Text option is used to edit the text on a tree label.  When you create a new envelope assembly 
or HVAC component, a new row appears in the corresponding table and a new tree label appears on 
the tree to the left.  The tree labels are assigned default names such as Roof 1 .  These labels can be 
changed by clicking the right mouse button on the label and selecting Edit Text from the context menu.  
An edit box will become visible where the label used to be, and you can rename the label by typing in 
the edit box.  Press Enter or click elsewhere when finished.  You can enter a maximum of 32 
characters in the edit box.  You can also edit tree labels by double-clicking on the label. 
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Edit Inputs Basement wall, crawl space wall, and slab-on-grade assemblies display screens which illustrate 
dimensions being requested of the user.  You may enter these dimensions directly into the illustration, 
then select the OK button to transfer them to the table on the Envelope screen.  You may change any 
previously entered dimensions directly on the table, or you may use the Edit Inputs option to redisplay 
the illustration with the previously entered values.  The Edit Inputs option can be selected by clicking 
the right mouse button on the tree label or table row of any basement wall, crawl space wall, or slab 
assembly.  The option name in the context menu changes to Edit Basement Inputs, Edit Crawl Inputs, 
or Edit Slab Inputs, depending on the row being selected. 

Compliance Example 
The software approach is illustrated in this section.  Assume that you plan to build the single-
family house shown below on a lot located in Greensboro, North Carolina. 

 

The following table lists the components that make up the building envelope, the area of these 
components, and the proposed insulation R-values and window and door U-factors.  To 
determine compliance, you only need to input the areas, R-values, and U-factors listed in this 
table into the software, which will then display the compliance results in the Compliance field.  
If desired, you can then alter any or all of these inputs to determine if a revised design still 
complies with the code. 

Determine Which Components Are Part of the Building 
Envelope 
Only the building components that are part of the building envelope are considered for code 
compliance.  Building envelope components are those that separate conditioned spaces (heated 
or cooled rooms) from outside air or from unconditioned spaces (rooms that are neither heated 
nor cooled).  Walls, floors, and other building components separating two conditioned spaces 
are NOT part of the building envelope. 
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Building Component Area Insulation Level 

Ceilings 
     With Attic (Std. Truss) 
     Vaulted 

 
729  ft2 
592  ft2 

 
R-38 
R-30 

Walls (2x4 @ 16-in. O.C.) 
     Without Sheathing(a) 
     With Sheathing 
 

 
  276  ft2 (gross) 
1647  ft2 (gross) 
 

 
R-13 
R-19 
(R-13 cavity + R-6 sheathing) 

Windows  204  ft2   U-0.45 

Doors  
     Sliding Glass Doors  
     Entrance 
     Garage to Family Room 

 
  84  ft2 
  20  ft2 
  18  ft2 

 
U-0.61 
U-0.54 
U-0.35 

Floors  
     Over Garage 
     Over Crawl Space 
     Slab (Unheated) 
     Bay Window Floor 

 
363  ft2 
575  ft2 
  82  ft2 (perimeter) 
  32  ft2 

 
R-19 
R-19 
R-8 (2-ft depth) 
R-30 

(a)  Walls without sheathing are located between the family room and the garage, the laundry 
room and the crawl space, and the garage and the living room. 

Table 1.  Example House Specifications 

Walls  In this example, the garage is unconditioned, so the exterior garage walls are not part of 
the building envelope.  The wall between the conditioned family room and the unconditioned 
garage is part of the building envelope, including the wall of the stairwell facing the garage.  
Likewise, the wall between the garage and the living room is part of the building envelope. 

Part of the laundry room wall separates the laundry room from the crawl space and the other 
part separates the laundry room from the kitchen.  The wall portion adjacent to the crawl space 
is part of the building envelope because it separates the conditioned laundry from the 
unconditioned crawl space.  The wall portion adjacent to the kitchen can be ignored because it 
separates two conditioned spaces.  The wall portion adjacent to the family room can also be 
ignored.  Likewise, the wall between the upstairs bathrooms and the kitchen and the wall 
between the center bedroom and the living room are not part of the building envelope.  
Portions of both of these walls are also adjacent to outside air, and those portions are part of 
the building envelope.  The following table lists the walls that are part of the building envelope 
and indicates whether sheathing is installed on them (which is relevant when determining the 
R-value of the wall). 

 

Wall Sheathing? Gross Area 

All walls between interior conditioned space and outside air Yes 1647 

The wall between the family room and the garage No 192 

The wall between the garage and the living room No 44 

The wall between the laundry and the crawl space No 40 

 

Ceilings  The dining room, living room, bay window roof, and entryway have a vaulted ceiling 
that will be insulated to R-30.  The area covered by the vaulted ceiling totals 592 ft2.  The rest 
of the home has a ceiling with attic which will be insulated to R-38.  Since these two ceiling 
areas will be insulated to different levels, they must be treated as two separate building 
components. 
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Floors  The example house has a conditioned floor area of 1714 ft2, but 378 ft2 of the floor 
area is located over the family room and is not part of the building envelope (both the family 
room and the rooms above it are conditioned).  The living room, dining room, and kitchen are 
over an unheated crawl space.  The family room and garage both have slab-on-grade floors.  
The floor of the bay window is a floor over outside air. 

Glazing and Doors  There are two sliding glass doors in the building envelope – one leading 
from the dining room to the larger deck and one leading from the master bedroom to the 
smaller deck.  There are two opaque doors in the building envelope – the front entry door and 
the door leading from the garage into the family room. 

Enter the Location 
On the Project folder, enter the location of the building and type of construction.  Enter the 
city and state as Greensboro, North Carolina, and the construction type as single family.   

Select the Code Year 
This example is based on compliance with the 1995 MEC.  Select the 1995 MEC option from 
the Code menu. 

Create the Building Components List 
Using the buttons at the top of the Envelope folder, create building components for the entries 
in Table 1.  If you need more than one building component of the same type, you must enter 
each component separately.  For example, you will need two different ceiling components 
since there are two different ceiling insulation R-values used in the example house.  Select the 
Ceiling button and choose All-Wood Joist/Rafter/Truss from the list of ceiling types.  This 
creates the first ceiling component. Repeat this step to create a second ceiling component.  
Create two 16" O.C. wood-framed wall components, one window component, three door 
components, two floor components (one All-Wood Joist/Truss - Over Unconditioned Space 
and one All-Wood Joist/Truss - Over Outside Air), and one unheated slab component with 2' 
depth of insulation.  There are actually two All-Wood Joist/Truss - Over Unconditioned Space 
components in Table 1, but they are combined since they both have the same R-value (R-19). 

After the building components have been created, fill in the areas, R-values, and U-factors 
from Table 1.  The Code UA field should show a total required UA of 466, and the field 
labeled Your UA should show a proposed UA of 415. 

Save and Print a Report 
Save the data you have entered by selecting the Save option from the File menu.  You will be 
asked to provide a name for the data file.  Print a compliance report and/or inspection checklist 
by selecting the Print Report option from the File menu.  You can exit MECcheck  by selecting 
the Exit option from the File menu. 

Check Your Work 
An example file (EXAMPLE.CCK) has been included with the MECcheck  software.  
EXAMPLE.CCK is a data file which contains the same data used in this example.  If you have 
any questions, the example file can be loaded into the software to show how the building used 
in this example should be entered into the software.  To load this file, select the Open option 
from the File menu. 
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Changing Location Files 
The following text provides instructions for changing from the city version of the MECcheck  
software to the county version. 

The MECcheck  software contains two location files: 

1. CITIES.MEC contains a list of cities for each state. 

2. COUNTIES.MEC contains a list of counties for each state. 

The useCounties variable contained in the CHECK.INI file determines which of these location 
files is used by the software.  To modify this variable, open the CHECK.INI file in a text 
processor (preferably NOTEPAD) and set useCounties to true or false.  By default, the 
software uses cities: 

useCounties=false 

You MUST save this file in an ASCII text format.  The best text processor to accomplish this 
is NOTEPAD. 

Noteworthy: 

If you have saved a data file for a building, the location for that building is also saved.  If you 
subsequently change the location file as described above and try to load that data file back into 
the MECcheck  software, MECcheck  will not find the specified building location and will set 
the location to a default.  Therefore, after loading the file into the program, you must go back 
to the Project screen and reselect your location. 

Modifying the Cities or Counties 
MEC and IECC code compliance is based on the heating degree-days based 65°F (HDD) of 
the location in which the building resides.  This section describes how locations that are not 
currently available within MECcheck  can be added and how the HDD values for existing 
locations can be modified.  You should not, however, modify the HDD value for any location 
without direction from your local jurisdiction.  If locations are missing or incorrect for a given 
jurisdiction, we recommend that you contact the MECcheck  technical support staff and request 
a change be permanently made.  Otherwise, any changes will be overwritten if newer versions 
of MECcheck  are later installed.  Technical support contact information is given on the splash 
screen that comes up when MECcheck  is first started. 

MECcheck accesses a list of cities or counties, depending on which version you are using.  The 
cities are stored in a file named CITIES.MEC and the counties are stored in a file named 
COUNTIES.MEC.  These files come with the MECcheck  software and should be located in 
the same directory as the MECcheck  executable file (MECCHECK.EXE). 

The first line of the CITIES.MEC file contains the word *cities and the first line of the 
COUNTIES.MEC file contains the word *counties.  This keyword tells the software whether 
cities or counties are contained in the file, and should not be changed.  The following text and 
illustration apply to the cities version.  However, modifications can be made to the counties 
version in exactly the same manner. 

The CITIES.MEC file begins with an alphabetical list of the states.  The second line of the file 
contains an asterisk (*) followed by the word states.  All asterisks are very important because 
they delineate the sections of the file. 

The list of states is followed by lists of cities for each state.  The cities for each state are listed 
separately, starting with the cities for Alabama.  The Alabama cities start directly after the line 
reading *Alabama . 
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Each city name is followed by fifteen climate values that apply to that city.  The first value 
represents the heating degree-days base 65°F (HDD), and the second value represents the 
cooling degree-days base 65°F (CDD).  Commas are used to separate the city name and 
climate values.  Commas MAY NOT be used as part of a city name.  Remove extra space on 
either side of all commas. 

If the CITIES.MEC or COUNTIES.MEC file is edited, care must be taken to save the new data 
in text (ASCII) format.  To preserve this format, use a text editor, such as NOTEPAD.  If a text 
processor such as Word Perfect or Microsoft Word is used, save the file as DOS text or ASCII 
text.  Copy the edited file to LOCATION.MEC. 

To Add, Delete, or Modify Cities 

1. Find the list of cities you wish to modify. 

2. Add, delete, or modify as many city lines as you wish.  Each new line must 
adhere to the format described above.  To add a new city, find the city in the file 
closest in location and weather to the city you want to add.  Copy the existing 
city line to the correct alphabetical location for the new city.  Change the city 
name to the new city name.  You may modify the HDD and/or CDD values to 
match the new city values, if known.  Do not modify any of the other climate 
data. 

To Delete an Entire State 

1. Delete the state name from the list of states located at the beginning of the file. 

2. Delete the list of cities corresponding to that state.  Be sure to delete all cities 
AND the name of the state which precedes them. 
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Appendix A:  Additions   

What is an Addition? 
1998 Additions to existing buildings must comply with code requirements when the addition is 

within the scope of the code and would not otherwise be exempted.  An addition is any 
extension or increase in the height, conditioned floor area, or conditioned volume of a 
building. 

2000 Additions, alterations, and repairs to existing buildings must comply with code 
requirements when the addition, alteration, or repair is within the scope of the code and 
would not otherwise be exempted.  An addition is any extension or increase in the height, 
conditioned floor area, or conditioned volume of a building.  An alteration is any 
construction renovation, or change in the mechanical system that involves an extension, 
addition, or change to the arrangement, type, or purpose of the original installation.  A 
repair includes the reconstruction or renewal of any part of an existing building for 
maintenance purposes. 

Additions include new construction, such as a conditioned bedroom, sunspace, or 
enclosed porch added to an existing building.  Additions also include existing spaces 
converted from unconditioned or exempt spaces to conditioned spaces. 

For example, a finished basement, an attic converted to a bedroom, and a carport 
converted to a den, are additions.  An unconditioned garage converted to a bedroom is an 
addition, but the addition of an unconditioned garage would not be considered within the 
scope of the code, since the code applies to heated or cooled (conditioned) spaces.  If a 
conditioned floor area is expanded, such as a room made larger by moving out a wall, 
only the newly conditioned space must meet the code.  A flat window added to a room 
does not increase the conditioned space and thus is not an addition by this definition.  
However, replacement windows that are not part of an addition must meet the 
prescriptive U-factor requirements given in Table 1. 

Compliance Options for Additions 
The addition (the newly conditioned floor space) complies with the code if it complies 
with all of the applicable code requirements.  For example, requirements applicable to the 
addition of a new room would most likely include insulating the exterior walls, ceiling, 
and floor to the levels specified in the code; sealing all joints and penetrations; installing 
a vapor retarder in unventilated framed walls, floors, and ceilings; identifying installed 
insulation R-values and window U-factors; and insulating and sealing any ducts in 

1998 IECC and 2000 IECC 
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unconditioned portions or exterior components (walls, ceilings, or floors) of the new 
space. 

There are three approaches by which an addition can comply with the code: 

• The addition as defined above meets all code requirements.  This approach 
does not require that the original portion of the building meet code 
requirements. 

• If the building with the addition complies with the code, the addition will 
also comply, regardless of whether the addition complies alone.  For 
example, a sunroom that does not comply with the code is added to a house.  
If the entire house (with the sunroom) complies, the addition also complies. 

• Additions less than 500 ft2 (46.5 m2) of conditioned floor area may meet the 
prescriptive envelope requirements in Table1.  To use this table, the total 
area of windows, doors, and skylights cannot exceed 40% of the gross wall 
and roof area of the addition. 

 

Table 1.  Prescriptive Requirements for Additions and Replacement Window 

 Maximum Minimum 

 
 
 

Climate 
Zone 

 
 
 

Fenestration 
U-factor (a) 

 
 

Ceiling 
R-value 

(b) 

 
 
 

Wall  
R-value 

 
 
 

Floor 
R-value 

 
 
 

Basement 
wall R-value 

Slab 
perimeter 
R-value 

and depth 
(c) 

 
 

Crawl 
space wall 
R-value (d) 

1-4 0.75 R-26 R-13 R-11 R-5 R-0 R-5 

5-8 0.5 R-30 R-13 R-19 R-8 R-5, 2 ft R-10 

9-12 0.4 R-38 R-18 R-21 R-10 R-9, 2 ft R-19 

13-15 0.35 R-49 R-21 R-21 R-11 R-13, 4 ft R-20 

16-19 0.35 R-49 R-21 R-21 R-19 R-18, 4 ft R-20 

a. The area-weighted average U-factor for all windows, doors, and skylights in the 
addition must not exceed the fenestration U-factor requirement.   
b.  Floors over outside air must meet ceiling R-value requirements. 
c.  The slab R-value requirements are for unheated slabs.  Add an additional R-2 for 
heated slabs. 
d.  The crawl space wall R-value requirements are for walls of unventilated crawl spaces 
only. 

2000 e.  The maximum U-factor for replacement skylights is 0.5 in Zones 5-19. 
2000 f.  The area-weighted average solar heat gain coefficient (SHGC) of all windows, glazed doors, and 

skylights cannot exceed 0.4 in Zones 1-7. 
 

Replacement Windows 
Replacement windows that are not part of an addition must meet the prescriptive 
requirements of Table 1.  A replacement window is defined as a replacement of the entire 
unit, including the frame, sash, and glazing. 
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Appendix B:  Default U-Factors 
and SHGC Values 

Glazing and Door Defaults 
The following tables provide default U-factors and SHGC values for glazing and doors based on the 
glazing or door features.  The U-factors and SHGC values in these tables can be used in the absence of 
NFRC-labeled values. 

Glazing and doors cannot receive credit for features that cannot be clearly detected, such as argon gas 
fills and low-emissivity (low-E) coatings.  Windows with these features may achieve much lower U-
factors than those listed in Table 1.  For example, a double-pane wood or vinyl window with low-E 
glass may have a U-factor around 0.38.  The same window with argon gas may be rated at 0.34.  
Therefore, it may be advantageous to use NFRC-rated test U-factors for these types of windows. 

Where a composite of materials from two different product types is used, the window or door must be 
assigned the higher U-factor. 

 

1998 IECC and 2000 IECC 
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Table 1.  U-Factors for Windows, Glazed Doors, and Skylights 

Frame  Material and Product 
Type(a) 

Single Glazed Double Glazed 

Metal Without Thermal Break   

    Operable (including sliding 
    and swinging glass doors) 

    Fixed 

    Garden window 

    Curtain wall 

    Skylight 

    Site-assembled sloped/ 
    overhead glazing 

 
1.27 

1.13 

2.60 

1.22 

1.98 

1.36 

 
0.87 

0.69 

1.81 

0.79 

1.31 

0.82 

Metal With Thermal Break   

    Operable (including sliding 
    and swinging glass doors) 

    Fixed 

    Curtain wall 

    Skylight 

    Site-assembled sloped/ 
    overhead glazing 

 
1.08 

1.07 

1.11 

1.89 

1.25 

 
0.65 

0.63 

0.68 

1.11 

0.70 

Reinforced Vinyl/Metal-Clad Wood   

    Operable (including sliding 
    and swinging glass doors) 

    Fixed 

    Skylight 

 
0.90 

0.98 

1.75 

 
0.57 

0.56 

1.05 

Wood/Vinyl/Fiberglass   

    Operable (including sliding 
    and swinging glass doors) 

    Fixed 

    Garden window 

    Skylight 

 
0.89 

0.98 

2.31 

1.47 

 
0.55 

0.56 

1.61 

0.84 

Glass Block Assemblies  0.60 

 

Table 2.  U-Factors for Non-Glazed Doors 

Steel Doors  

    Without Foam Core  0.60 

    With Foam Core  0.35 

Wood Doors Without Storm With Storm 

    Panel With 7/16-in. Panels  0.54 0.36 

    Hollow Core Flush 0.46 0.32 

    Panel With 1 1/8-in. Panels  0.39 0.28 

    Solid Core Flush 0.40 0.26 
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Table 3.  SHGC Values for Windows, Glazed Doors, and Skylights(a) 

Single Glazed Double Glazed  
 

Product Description  
 
Clear  

 
 
Bronze 

 
 
Green 

 
 
Gray 

Clear  
+ 

Clear  

Bronze 
+  

Clear  

Green 
+  

Clear  

Gray  
+  

Clear  

Metal frames  
   Operable  
   Fixed 

 
0.75 
0.78 

 
0.64 
0.67 

 
0.62 
0.65 

 
0.61 
0.64 

 
0.66 
0.68 

 
0.55 
0.57 

 
0.53 
0.55 

 
0.52 
0.54 

Nonmetal frames  
   Operable  
   Fixed 

 
 

0.63 
0.75 

 
 

0.54 
0.64 

 
 

0.53 
0.62 

 
 

0.52 
0.61 

 
 

0.55 
0.66 

 
 

0.46 
0.54 

 
 

0.45 
0.53 

 
 

0.44 
0.52 

a.  SHGC values may be adjusted to reflect the effects of any permanent exterior solar shading devices, 
such as shade screens. 

 


